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Installing and Licensing

1

There’re 3 steps of SuperSurv

installation. First, download the

installation program from CD to

the desktop computer. Second,

connect to computer via mobile

device. Next, copy the program

to mobile device and install it.

Since you have to be authorized

to use SuperSurv, this section will

also detail the software licensing

method.

1.1 Download Related 

Applications to 

Mobile Device

1.2 Installation

1.3 Licensing
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1 Installing and Licensing

1.1 Download Related Applications to Mobile Device

Download Related Applications to Mobile Device

To install SuperSurv, you need to use installation CD to install SuperSurv in PC. Then,
copy the installation file (SuperSurv.apk) from PC to mobile device. 

Since there is no built-in Windows-explorer-like application in Android mobile device for
users to browses files, it is suggested that you download the related file explorer
application from Android Play Store, such as ES File Explorer and install it. Therefore,
it would help you browse the files easily. Besides browsing installation file, the file
explorer App enables users to browse any other files saved in the mobile device.
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1.2 Installation

Installation

The procedure of installing SuperSurv is to install SuperSurv from CD to PC, connect
PC with mobile device, and copy the installation file to mobile device to install. 

1. Insert CD to CD-Rom drive and the installation window appears. If the window does
not appear, please double click CD-Rom drive, and click Install SuperSurv 10.
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2. As InstallShield Wizard appears, click “Next.”

3. Select “I accept the terms of the license agreement” and click “Next.”
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4. “Ready to install the program” appears, click “Install.”

5. As the installation is completed, click “Finish.”
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6. Click Start > Programs > SuperGeo > SuperSurv 10 > Install SuperSurv. 

    

7. In the folder of Install SuperSurv, please copy “SuperSurv.apk.”

    

8. Connect mobile device with PC, and set the connection type as Disk Drive.
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9. Paste “SuperSurv.apk” to the directory of mobile device.

10.Set the connection type other than “Disk Drive”, and start to install SuperSurv.apk.  

11.Tap SuperSurv.apk.
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12.Tap Next to install. 
 

13.As the installation is completed, tap “Done.”
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1.3 Licensing

Licensing

1. If you have not got the license, the screen will show the message below as you start
SuperSurv. If you have purchased SuperSurv, you can tap License to enter the serial
number. If it is a trial version, please tap Trial, and you will have 10-minute trial.  

    

2. Please Enter the serial number and tap OK. As the application is licensed
successfully, it will start SuperSurv automatically. 
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This section introduces the

common functions of SuperSurv,

and you can quickly learn the

processes of operation.

The mobile survey system

can help you to collect data and

offer some common functions,

like GPS Positioning, Waypoint,

Track and Survey. In the process

of survey, you can use functions

of track and waypoint to find the

location and recorded path. It

surely and completely fulfill your

needs in field survey.

2.1 Quick Start Guide

2.2 Browsing Map

2.3 Pan to

2.4 Creating a New Project

2.5 Online Map Tool Project

2.6 Switching Online Map

2.7 GPS Positioning

2.8 Open a Project

2.9 Creating a New Layer

2.10 Adding Layers

2.11 Editing Layers

2.12 Layer Management

2.13 Adding SGT Base Map or 

STC Base Map

2.14 Online Editing Feature 

Service

2.15 Waypoint 

2.16 Track

2.17 Query

2.18 Measure Tools
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2 Quick Tutorials

2.1 Quick Start Guide

Quick Start Guide

The Quick Start Guide will be shown while you start SuperSurv, illustrating commonly
used functions with simple texts and pictures step by step. You can also turn off this

function by uncheck the Show the quick guide on startup option. Tapping  will
lead you to the main map on SuperSurv.
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 You can find quick guide pages if you want to read it again by tapping the menu button
> Settings/View > Quick Start Guide.

2.2 Browsing Map

Browsing Map

At the lower-left bottom of the map, there is a map tool bar that helps you to browse the

map with different tools with ease. Map Tool includes Zoom in , Zoom out ,

and Full extent . Users can adjust the extent they need. Also, users can zoom in
the map with 2 fingers or tap the map twice to zoom in the map. Or you can tap the
North arrow to show electronic compass so that it is easier for you to identify the
correct aspect and angle in the real world environment.
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2.3 Pan to

Pan to 

The system provides two ways to position, including Pan to GPS, and Pan to waypoint.
Users can choose the way of positioning they need according to their situation.
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2.4 Creating a New Project

Creating a New Project

SuperSurv  works  with  a  project  environment.  All  the  layers,  track  files,  photos
generated  by  SuperSurv are  saved  in  a  project  environment,  while  all  the  settings  of
projects are saved in SPP project  file.  When you start  SuperSurv for the first  time,  the
system will  ask  whether  to  create  a  project  file.  If  SuperSurv has  been  used,  as  the
system  starts,  you  can  tap  uper-right  bottom  on  the  mobile  device  >  Create  a  new
project  to build  a  new project  environment.  To  create  a  project  with  Online  Map  Tool
please refer to Online Map Tool Project.

 

To create a new project,  you need to name  the  project  and  set  the  spatial  reference.
What  should be noted  is  that  project  name  and  spatial  reference  cannot  be  modified
after being set. Tap “Please select” to set spatial reference.

The  coordinate  systems  provided  by  spatial  reference  include  geographic  coordinate
systems  and  projected  coordinate  systems.  In  addition,  users  can  also  build
customized  coordinate  system  by  importing  PRJ  file.  Please  choose  the  coordinate
system you need and click OK.
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As the project is created successfully, the system shows up. 
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SuperSurv supports  to use GIS vector layers,  including GEO and SHP file format.  The
way to create a new layer,  please refer to Creating a  New  Layer.  Besides,  you  can
add a SGT basemap or a STC basemap to enrich the map.  The way to generate STC
basemap please refer to SuperGIS Desktop or SuperGIS Server User Guide.  About  the
way to add the two kinds  of  base  maps,  please  refer  to  Adding  SGT  Base  Map  or
STC Base Map. 

As  you  build  a  project  environment  successfully,  a  folder,  SuperSurv,  will  be  built
directly in sdcard.  The folder contains  a folder named after the project  to save the files
related to the project  and a Template folder.  For example,  the project  name is  “project
1”, and the project folder is named after the project.

The project folder includes the subfolders: 
Layer: All the layers created in the project are saved in the folder. To add the existing
layers to use in SuperSurv, you can copy the layers (SHP/GEO) to Layer folder. Then,
start SuperSurv, tap Manager Layer > Add Layer, you can therefore add the layer to
map by checking it. 
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Photo: Photos taken with SuperSurv are saved in the folder
Track: All the track files recorded with SuperSurv are saved in the folder
Waypoint: Waypoint files exported from SuperSurv are saved in the folder
SPP file: SPP project file 

Therefore, every time you create a new project, SuperSurv folder will create the folder
and subfolders. 

2.5 Online Map Tool Project

Online Map Tool Project

To create a project with Online Map, like OpenStreetMap, as base map please follow
the steps below.

Choose Online Map Tool Project on creating a new project.



Quick Tutorials

23

Enter the project name, the Spatial Reference is grayed out. 

Tap the Map Type and choose a online map on the menu to be your project's base
map. Click OK.
Return to the map and Online Map displays.
    

The internet connection of the device must be confirmed available before creating a
project with Online Map Tool so that users can access the online map. 
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2.6 Switching Online Map

Switching Online Map

A variety of online maps are provided  with Online Map Tool and users are free to
change online map on SuperSurv at any time.

Tap Layers . Tap Online Map to enter the layer setting page.

Tap Map Type and select the online map to use and tap OK. 
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The map is changed to new one.

2.7 GPS Positioning

GPS Positioning   

To display the current GPS position on the map, please tap   on the upper-right

corner to pan to the current GPS position. Then, a purple mark  will be displayed
on the map. The fan-shaped area is the visual angle. The longitude and latitude
information will be displayed on the top of the map; tapping the information can convert
to project coordinate system. 
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2.8 Open a Project

Open a Project

As you close SuperSurv,  the system will  save the project  environment  in  SPP  project
file.  Next  time you  start  SuperSurv,  the  system  will  read  the  settings  of  the  previous
project  as  default  display.  If  you  would  like  to  open  other  projects,  please  tap  Menu
function on the mobile device and choose open project to open another project. 
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2.9 Creating a New Layer

Creating a New Layer 

If you have no available layers, please create a new layer. Tap and choose a
layer you want.
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In the  setting  page,  please  enter  the  layer  file  name,  layer  name,  select  code  page,
layer type (point, line, polygon) and choose the file format  (SHP or GEO).  After setting
is finished, tap OK.  

Field setting dialog appears, choose Start to Customize Table, and tap OK. 
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In “Create a New Layer”, set the field name and field properties. You can tap a field to
set the field format in Field Setting. 

To create a new field, please tap , “Create a new field” appears. Please select a field
type and set the format. About the details of the field type and format, please refer to 
Custom Table.
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After the setting is finished, please tap OK and back to the map. Survey toolbar shows
up on the top of the map.  

Then, there are two modes. One is add . The other one is edit . When it
is add mode, you can choose type of layer, and create features.
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After a feature is created, if you would like to enter attribute data, you can long-press
the feature you created in edit mode. Then the attributes page will show up. You can
edit the attribute data in Enter Attributes page. 

Also, you can edit the attributes right after a feature is created. Please tap Survey

Setting , and set “Input attributes after creating a feature” as On and tap OK. Back
to the map, you can see Enter Attributes page right after a feature is created.
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2.10Adding Layers

Adding Layers

As  you  have  created  multiple  layers,  you  can  apply  Add  Layer  function  to  add  the
specified layers to the map. 
In this function, you can add geopdf file or any layer file from Google drive and Dropbox.

The layers that are not chosen will not be display  on the map.  Tap  ,  and all  the
layers  are listed here.  Or you can copy the layer you want  to add,  and paste it  to the
folder. Back to SuperSurv, the map displays the selected layers. 

Original layer
Copy all the project files into

layer folder

Open SuperSurv again, the
new layer will show up in the

list

How to add the existing layers to SuperSurv map? To add existing layers to use in
SuperSurv please copy the existing layers to Layer folder of SuperSurv folder, start
SuperSurv, so that the Add Layer list will include the added layers. Check the layers to
display and you can see them displayed on the map. 
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2.11Editing Layers

Editing Layers

To edit layer, you need to specify the layer you want to edit. Tap .

In Please Select Editable page, select the layer you would like to edit. Then tap OK. 
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The editable SuperGIS Server Feature Service will be listed as editable layer, when
such layer is selected, all the layers contained by this Feature Service will be listed as
editable SuperGIS Server layers. The way to edit SuperGIS Server layer is the same as
to edit ordinary layers. 

Please note that you can only edit a layer each time and you cannot edit multiple
layers at the same time. To edit another layer, you need to switch another layer. Back
to map, Survey toolbar shows up at the top of the map. 
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As a feature is selected, you can use the following buttons: 

Delete Feature 
Delete the selected feature. 

Move Feature 
Press  the  selected  feature.Move,  vertex,  stretch  feature,
rotate feature, insert vertex, and delete vertex. 

Edit Attribute Long-press the selected feature. 

Survey  toolbar  setting

5 items to set: 

a. Input attributes after creating a feature: 
Whether to show up attribute window right after a
feature is create. ON is Yes, OFF is Not. 

b. Sampling time for collecting a GPS position: 
Set the sampling time for collecting GPS
positions. The longer the time bar is, the longer
time it takes. 

c. Interval for continuously collecting GPS
positions: Set the Interval for continuously
collecting GPS positions (line layer/ polygon layer)

d. Outline color when editing feature: Set the
outline color when editing feature.

e. Snap to vertex when editing features: Set up
the snapping tolerance for vertex editing, the unit is
pixel. 

You can stop the current editing by 2 methods: 1. tab  2. press Back key, and a
dialog will appear to check whether you would like to finish the editing. Tap OK to finish
editing. The details of editing, please refer to Survey. 

A message will show up to confirm whether users want to synchronize data to Server
upon the editing is finished. Please tap Yes if you want to synchronize the data,
otherwise, tap No.

2.12Layer Management

Layer Management
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With Layer Management, you can add a layer to the map and set the properties of the
layer. If you create a new layer, you can customize tables to enter the attribute data
rapidly.

2.13Adding SGT Base Map or STC Base Map

Adding SGT Base Map or STC Base Map

In addition to adding GIS layers, you can add SGT base map or STC base map to
make the map more complete and abundant. Tap Menu button on the mobile device>
Settings/View > Set base map and choose the SGT project file or STC project file. Then
tap Ok. 

                              

 

Note: STC map includes 2 files, .stc and .stp; both of the files should be copied to your
mobile device. While selecting the basemap, please select *.stp file.
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Back to Settings/View, and tap Back key, and tap Yes in the dialog. 

Back to the map,  the SGT basemap or STC basemap is  added to the map.  A  project
file can contain one SGT basemap or one STC basemap only. 

   

The way to create STC project file, please refer to SuperGIS Desktop or SuperGIS
Server User Guide.

2.14Online Editing Feature Service

Online Editing Feature Service

Feature Services published by SuperGIS Server can be displayed on SuperSurv and
those editable services can be edited with features and attributes. Furthermore, the
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editing can be synchronized to SuperGIS Server. In addition, Feature Service attributes
can be queried and be measured just like the ordinary layers. 

Tab menu button > Settings/View > Set SuperGIS Sever.

Tab   and key in name, server, account and password.

After setting finished, press OK and go back to SuperGIS Sever Setting page. Then you
will see the server shows up.



Quick Tutorials

39

Remember save your setting before go back to map. 

Then get the SuperGIS map.
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2.15Waypoint

Waypoint

You can set and manage waypoints and pan to the waypoint. Besides, you can display
the waypoint information on the map to help reaching destination. Or you can use AR
(Augmented Reality) to help find the correct direction and distance to the destination.  

Waypoint guidance Waypoint management AR

Adding Waypoints

Adding Waypoints

In field survey,  you  might  need  to  add  some  points  to  survey  temporarily  because  of
accidents or missions. Then, you can create new waypoints  to complete the operation.
Or  when  you  are  surveying,  you  might  need  to  add  some  point  information  (e.g.
building, tree, etc.) for references, you also can apply waypoints to achieve the target. 
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1. Press menu > Add Waypoint.

2. Tab the place you want on the map or tab  to set waypoint and "Add
Waypoint" window shows up, please select the coordinate system, and enter
waypoint name and Z value. The coordinate fields (longitude, latitude, elevation)
shows the current coordinates. You can modify the coordinate values manually.
Please tap OK to finish.
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3. Waypoint is successfully added. The name of waypoint is also displayed on the
map. 

Note:
The function can be worked with Positioning function to rapidly zoom to the target
position and add the new waypoint by long-pressing.
You can also use waypoints as an annotation of points on the map.
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Importing Waypoints

Importing Waypoints

If you have known the route of field survey and there are several locations you must
pass by, you can edit the coordinates of the locations on PC and then import the
locations to SuperSurv. In field survey, you can apply waypoint to know the relative
location between current position and the locations you must pass. The system
supports to import TXT, CSV or KML.

Besides, if you want to display some more information on the map, such as rain gauge
station, hospitals, scenic spots, etc. you can apply notepad to create the coordinate
data. Then, the text file can be imported to the system. The coordinate data can be
displayed as points on the map and help you know the positions of the points
effectively. 

The following is the way to create TXT file to import waypoints.
1. Connect your PC with the mobile device. 

2. Start notepad on PC, and enter waypoint name, X coordinate, Y coordinate, and Z
coordinate. 

3. After entering, please save the file. Then copy the file to your mobile device. 

Note:
While editing waypoint information in notepad, enter Name, X, Y, Z in the first row.
Then, enter the information of each point in each row.
Name, X, Y, and Z stand for waypoint name, X coordinate of waypoint, Y coordinate
of waypoint, elevation of waypoint.
The supported coordinate systems are WGS84, TWD67, and TWD97. if you use
WGS84, the system only supports “degree.”
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4. In SuperSurv, tap menu > Add Waypoint. > Tap settings button  on waypoint
toolbar.

5. In Waypoint management window, tap import. 
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6. Select the file you created in Step 2, and tap OK. 

7. Back to waypoint management window, tap Back key, and the message appears.
Tap Yes. 

8. Back to the map, and you can see the imported waypoints. The icon on the map
stands for the position of waypoint. The waypoint name is disaplyed above the icon. 
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Exporting Waypoints

Exporting Waypoints

Surveying with SuperSurv in  the  field,  you  can  work  with  waypoint,  and  the  waypoint
can be used  as  an  annotation  of  position  (please  refer  to  Adding  Waypoints).  After
surveying, you can export the waypoints to export the points to check and display  them
on different platforms. 
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1. In SuperSurv, tap menu > Add Waypoint. > Tap settings button  on waypoint
toolbar. 

2. In Waypoint management window, the waypoints will be listed on the left, and Export
is on the right. You can export all the waypoints as files. 
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3. Enter the file name and choose the file format to export. There are 3 formats, KML,
TXT, CSV. After setting, please tap OK.

The waypoint is exported successfully. The message will show up and display the path.

Note:
Waypoints can be exported and saved as TXT, CSV, KML formats. You can upload the
data to PC, other applications, or on Google Earth.

2.16Track

Track

After turning on GPS, you can record GPS track. In addition, you can also display the
track on the map that helps to know the route you move.
Tab menu button > Plugin Settings > check the "Track" item.
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Go back to map.

Then, please refer the steps: 

1. Tap Plugin Settings button  > tap  track . The Track toolbar will show up

on the screen. Tap  to start recording. The upper-left corner will show the
Recording. 
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2. While recording, You can tap   to pause to record, and then the upper-left

corner will show the message . Tapping  again to continue to record. You
can tap Pause to record and start recording for more than once. During the process,
the track will be saved in the same track file. 
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3. As you would like to stop recording, please tap  to stop recording. The upper-
left corner shows the message . Then, the track file will be saved directly. The file will
be saved in Track folder in the project folder. 

Note:
Track recording only works when GPS positioning works successfully.
The name of track file isYYYYMMDD_XX; YYYY is year, MM is month, DD is day, XX
is the order of the file created on the same date, for example “20110328_02” is the

second file generated on March 28th in 2011.
Files are saved in point layer (*.kml) and line layer (*.shp) in Track folder in the
project folder.
If you did not close the system in a normal procedure, the current track will be saved.
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2.17Query

Query

The system provides 3 methods to query: attribute query, identify query and coordinate
query. 

1. Firstly, you need to set the query conditions, tap Query , and then query
selection will pop up. 

2. Tap settings  to set the settings. Attribute Query only allows users to query a single
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layer; Identify Query allows users to query multiple layers, you can select all layers
by checking “Select All.” Coordinate query enables users to query the coordinate
information by tapping. 

3. After setting the layers, the layer you set to query will be displayed below Setting.
Then, you can set the fields you would like to query of each layer. Both Attribute
query and Identify query are able to set to query multiple fields or you can check
“Select All” to select all fields. Attribute Query and Identify Query both allows users
to set multiple fields. After setting, please tap OK. Then, back to Set Query
Conditions page, the fields you set to query will be listed here as well. 
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4. As the setting is finished, please tap Back key on the mobile device, and tap yes in
the dialog. 

5. Back to the map, and you can start to query. Tap Query  > Select Attribute
Query. Then, the dialog shows up; please set the key words, value, or range. Or you
can fuzzy inquiry by entering some key conditions. Tap OK. The features that meet
the conditions will be displayed and panned to the map center. 
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SuperGIS Server layers can be queried as the ordinary layers. All layers contained in
the SuperGIS Server layer will be listed for user to select. And the way to query
SuperGIS Server layers are the same as to query ordinary layers. 

2.18Measure Tools

Measure Tools

In field survey,  if you would like to know the real  length  or  area  on  the  map,  you  can
measure  with  the  tools.  Besides,  the  system  also  provides  the  function  to  measure
features. Please refer to the description to operate:  

Line Measurement Area Measurement
Feature

Measurement
Undo



SuperSurv 10 Help

56

    
1. Tap Measure, and the measurement toolbar will show up. 

2. Tap length measure   or area measure . 

3. Tap Undo , you can cancel the current measurement. 
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4. The system will calculate the total length or area of the segment or extent and

display the results on the map.

5. Tap “Measure Feature ” and tap on point, polyline or polygon feature on the
map to respectively get the XY coordinates, length, perimeter and area. Users can
also measure SuperGIS Server layer features. 
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6. Tap back button of mobile device, you can close the measurement mode.

Note:
Line measurement units include: meter and kilometer (the line longer than 1000 m
will be displayed with km); area measurement units include: square meter, hectare
(the area larger than 10000 square meters will be displayed with square hectare), and
square kilometer (the area larger than 1000 hectare will be displayed with square
kilometer)
The message below will show up if you are measuring but switch to different
measurement or tap finish measurement. Tap OK and the current measurement will
be canceled.
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This section will describe the

functions and operations of each

tool in the different sections. It

will also describe the details of

the timing and procedures of all

functions. Therefore, you can use

SuperSurv efficiently and totally

understand all function .

3.1 An Overview of 

Functions

3.2 Exit System

3.3 Menu

3.4 Map Toolbar

3.5 Survey

3.6 Manage Layer

3.7 GPS

3.8 Track

3.9 Query

3.10 Measure
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3 Detailed Function Description

3.1 An Overview of Functions

Major System Interface

Major System Interface

The major system interface includes “map display”, “map toolbar”, “upper function list”
and “lower function list.” 

    

Map Display  The loaded files will be displayed here.
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Map Toolbar
 The toolbar at lower left corner is the map toolbar.
 You can Zoom in and out, or zoom to full extent with tab  
 the icon.

Upper Function List
 The function list at top of the major interface includes
 "GPS Orientation" and "Menu."

Lower Function List
 The function list at bottom of the major interface includes
 "Measure", "Query", "Survey' and "Layer 
  Management."

 
Tapping “Menu” button of the mobile device will open a menu which allows you to open/
save project, create project, enter “Settings/View” and “About.”

In Settings/View page, you can use Map element and tap settings, Set base map, GPS
Setting, Dimension setting (Measure Function), View Location information, View project
information, Plugin Settings, Set SuperGIS Server. As to the details of how to set these
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items please refer to settings/view.

”About” shows the copyright and the software version. You can exit by tapping “Close.” 
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Function Description

Function Description

Upper Function List

Funtion Description

GPS Orientation 
 Pan map to the current GPS position.
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Funtion Description

Menu

  Open menu.

Menu button menu

Function Description

Create Project  Creates Projects.

Open Project  Opens Projects.

Save Project  Saves Projects.

Setting/View

 Sets Map element and tap settings, Set base

 map, GPS Setting, Dimension setting (Measure 

 Function), View Location information, View 

 project information, Plugin Settings, Set 

 SuperGIS Server. 

About  Announces the copyright and software version.

Lower Function List
  

Function Description

Measure

 Measure length or area by drawing polyline and 

 polygon. 

 Measure feature.

Query

 Query features: attribute query, identify query, 

 coordinate query and settings.

Survey

 Creates layers.

 Add waypoints.
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Function Description

Layer Management

 Adds layers.

 Sets the order of layers, symbol style and size.

 Customizes the attribute table.

Map Toolbar

Function Description

Zoom in
 Zooms in map.

Zoom out
 Zooms out map.

Full extent
 Zooms map to full extent.

Compass

 Show electronic compass so that it is easier for 

 you to identify the correct aspect and angle in 

 the real world environment.

3.2 Exit System

Exit System

Tap Back key, and the message will appear to ask you whether to exit the system. Tap
OK, and the system will close.
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3.3 Menu

New Project

New Project

Enter the project name and set the spatial reference to create a new project. 
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Or create a Online Map Tool Project which has online map as the base map.

Creating Online Map Tool Project

Creating Online Map Tool Project
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Online Map can be used to be the basemap in SuperSurv project by creating a
SuperSurv Online Map Tool project. Internet connection is necessary to connect online
map, please confirm the Internet connection works.  

Tap "Online Map Tool Project" and tap OK.

Enter the project name, Spatial Reference will be grayed out.
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Tap the Map Type and a menu shows up. Choose one online map to be the basemap
and tap OK.
Return to the map, Online Map shows.

Open Project

Open Project

You can open the existing project. As the menu shows up, you can select a project,
and tap OK. 
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Save Project

Save Project      

     
You can save the project. If you leave the system without saving, the system will save
the project for you. 
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Settings/View

Settings/View

Tap Settings/View and you can setting 9 items.
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Map Element Setting

Map Element Setting

You can set whether to display north arrow, scale, visual angle and to activate snap
tolerance.
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The top of the map always points to the north, but the aspect of the actual environment

might not be the same. At the moment, you can tap the north arrow  on the map
to show the electronic compass to indicate the north aspect of the current environment.
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Snap tolerance takes effect in Query, Waypoint and Measure, which allows users to
select the needed position more flexibly while manipulating. The unit is pixel. Take
Identify query as an example. See the figure below that the center of the circle is where
the query tapping is performed. If the tolerance is 5, the point feature is located outside
the query range, so it will not be performed query; if the tolerance is 10, the point
feature is inside the query range, so it will be performed query.
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Set Base Map

Set Base Map

Please specify the path of SGT layer or STC layer. The coordinate system of the SGT
Layer or STC Layer should be the same as the one of the project. Please tap OK. Back
to Settings/View page, tap Back key. The message, “Do you want to save?” appears,
tap Yes.
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The way to create STC project file, please refer to SuperGIS Desktop or SuperGIS
Server User Guide.

Map Background Color

You can specify the color of the area outside the base map; you can choose from the
20 basic colors or from the middle area. Current Color displays the color you choose.
Besides, you can set the transparency by dragging the bar. The higher the percentage
is, the more transparent the color is. After setting, please tap OK. Back to Settings/
View, tap Back key, the message will appear. Tap Yes. 
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Apply the background color to the map. 
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GPS Settings

GPS Settings

Users can choose a GPS signal through GPS Settings. Tap the drop-down menu of
GPS Signal and you can find all the options which include GPS Off, Internal GPS and
Bluetooth GPS.
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Dimension Setting(Measure Function)

Dimension Setting(Measure Function)     

            
Set to display the measurement result in metric units or imperial units.
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View Location Information

View Location Information

You can view the information related to the current location, including General, Details,
and Satellite. 
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View Project Information

View Project Information

Provide the information related to project name, path, spatial reference, etc.
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OGC Service

OGC Services

Setting WMTS Server

Input the WMTS service address in URL, tap Get Layer(s), when the layer name shows
in Layer, tap the downward arrow to show layer menu and select the layer you want to
add to SuperSurv. If account and password are required to access the service, please
enter both of them; if not, just ignore them.
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If you want to access TIANDITU, we suggest you to modify Tile DPI and set it between
95 and 96. As to the other WMTS services, please maintain the default value as 90.71.
To modify the Tile DPI, please uncheck Modify Tile DPI first and change the value. As
the value is changed, check Modify Tile DPI to finish it. Tap OK and save settings.
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Return to the map and you can see WMTS service displays on the map.
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Note Before using the WMTS connection, please make sure that the coordinate
system setting of your SuperSurv project is matched with the target WMTS service.

Setting WMS Server

 
1. Input the WMS address in URL. If account and password are required to access the

service, please enter both of them; if not, just ignore them.
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2. Tap select a layer and wait for WMS list. And then select a layer from the list.
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3. Choose SRS/CRS (projection system). Projection systems are defined by the
service provider. Therefore, you may find different projection systems in each service.
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4. Select Image format. The image format is also defined by the service provider.
Usually, service providers would apply image in PNG/GIF format to display services
with transparent effect. In other words, if you choose PNG as image format, you can
view other layers which under your current WMS layer. And services without
transparent effect offer BMP/JPEG.
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5. After setting, tap Back key. The message “Do you want to save?” appears. Tap Yes.



SuperSurv 10 Help

90

6. Tap the full-extent button, and then you can view the WMS in SuperSurv.
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Note
1. Before using the WMS connection, please make sure that the coordinate system
setting of your SuperSurv project is matched with the target WMS service.
2. The drawing of WMS is impacted by status of internet connection and configuration
of service provider. 

SuperGIS Server Settings

SuperGIS Server Settings

You can download SuperGIS Server map service to use in SuperSurv as long as you
finish the SuperGIS Server settings and successfully connect to it. In SuperGIS Server

Settings page one connection file is provided by default. Or you can tap  to add a
new connection file. 
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Then select a connection file and operate with the tools above.

: Delete the selected connection file.

: Edit the selected connection file, input data and click OK.
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: Set as the default conneciton file. More than one connection file can be created,
but the conneciton file you want to connect must be set as default so that the
SuperSurv can successfully connect to the right server. Select a connection file, tap 

 and you can see the screen shown as picture below. At the time, the selected
server is the default one. 
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In the next, tap  and a default service list shows up. Select the map service to
download to SuperSurv and tap OK.

Back to the map, the map service is added to the map.

Plugin Settings

Plugin Settings

Since SuperSurv 10, some functions or tool will become plug-in tool. To activate certain
plug-in tool, please refer the steps below:

1. Tap Menu > Settings/View > Select Plugin Settings > Select the tool you need
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2. Back to main screen and tap plugin button as you need to use it

Quick Start Guide

Quick Start Guide     

            
For helping user to make the best use of SuperSurv, Quick Start Guide had been built
up and offer various information about SuperSurv and field survey. User can decide
whether the Quick Start Guide to be shown or not while open up the project. Moreover,
user are also allow to turn on the Quick Start Guide in the setting page anytime during
usage.
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About

About

Tap Settings > About to view the version and copyright of the system. 
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3.4 Map Toolbar

Zoom In

Zoom In

 “Zoom In” enables users to zoom in the map by one level based on the map center.

1. Tapping “Zoom in ” will zoom in the map by one level. You can also zoom in the
map by the thumb and index finger or by double-tapping on the map.
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Zoom Out

Zoom Out

“Zoom Out” enables users to zoom out the map by one level based on the map center.

1. Tapping “Zoom out ” will zoom out the map by one level. You can also zoom
out the map by the thumb and index finger.
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Full Extent

Full Extent

”Full Extent” will zoom the map to full extent.

1. Tap “Full Extent ” to zoom the map to full extent.
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3.5 Survey

Create Layer

Create Layer

If you have no available layers, please create a new layer. Tap and choose a
layer you want.
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In the  setting  page,  please  enter  the  layer  file  name,  layer  name,  select  code  page,
layer type (point, line, polygon) and choose the file format  (SHP or GEO).  After setting
is finished, tap OK.  
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Field setting dialog appears, choose Start to Customize Table, and tap OK. 

In “Create a New Layer”, set the field name and field properties. You can tap a field to
set the field format in Field Setting. 



Detailed Function Description

103

To create a new field, please tap , “Create a new field” appears. Please select a field
type and set the format. About the details of the field type and format, please refer to 
Custom Table.
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After the setting is finished, please tap OK and back to the map. Survey toolbar shows
up on the top of the map.  
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Then, there are two modes. One is add . The other one is edit . When it
is add mode, you can choose type of layer, and create features.
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After a feature is created, if you would like to enter attribute data, you can long-press
the feature you created in edit mode. Then the attributes page will show up. 

 
You can edit the attribute data in Enter Attributes page. 
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Also, you can edit the attributes right after a feature is created. Please tap Survey

Setting , and set “Input attributes after creating a feature” as On and tap OK. Back
to the map, you can see Enter Attributes page right after a feature is created.
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Point Feature

Tab 
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Add Line Feature

Tap 
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Add Polygon Feature

Tap at the locations where you want to add vertices for the polygon feature. A polygon
must be created by three vertices at least, and system will auto-connect the vertices in
a line. The line will connect the last and first vertex, making it into a polygon. 
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Add Point Feature

Add Point Feature

1. Directly tap at the location where you want to add a point feature, and the point
feature is created.
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Add Line Feature

Add Line Feature

1. Tap at the locations where you want to add vertices for the line feature, and system

will auto-connect the vertices in a line. To finish the editing, please tap .
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Add Polygon Feature

Add Polygon Feature

1. Tap at the locations where you want to add vertices for the polygon feature. A
polygon must be created by three vertices at least, and system will auto-connect the
vertices in a line. The line will connect the last and first vertex, making it into a

polygon. To finish the editing, please tap .
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Custom Table

Custom Table

A custom table used to enter attribute values is a quick menu that is particularly
designed according to the features of the attribute to enable users to quickly enter
attribute values. For instance, there is a layer whose contents of attribute table should
be input in date format, in that case, the field format can be set as YYYY/MM/DD with
custom table. While users are editing the field, they can select a date by tapping
instead of typing each word. We will introduce each field type in this section. Each field
type has Field Name and Note. Field Name must be English or number, which is the
name recorded in the file; Note is the name displayed on the interface for users to
identify and input data, which can be any language or simple description to help users
easily know what the field records. They both are field names, the difference stands in
one is the name recorded in the file, while the other is used to be displayed for users to
read.
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To edit custom table, you need to specify the layer you want to edit. Tap .

In Please Select Editable page, the layer list appears. Please select the layer to
customize attribute table.
Please note that you can customize the attribute table only when no feature and no
attribute data has been created in the layer.



SuperSurv 10 Help

116

    
1. If you select “Start to customize table” in the beginning of creating layer, you can

follow the below steps to continue, because it works in the same way as “Custom
Table.” The “Create a new layer” page appears with multiple default fields. First
column is field name and the second column is field property. 

2. To add field, please tap , and a list of all field types appears. 
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3. Select a field type, the field setting page appears. Enter the field name and field note
and set up the property. Now we will introduce the property and effect of all types of
field.

Text: It is string, and should be input attribute value manually. Please set the length of
the field, the unit is bit.
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When you use “Edit Attribute”, you will enter the “Enter Attributes” page. To this type of
field, you need to enter the attribute value manually. 

Date: The system will show the date automatically, or you can change it by tapping.
Four types of data format are available YYYY/MM/DD, MM/DD/YYYY, MM/DD and DD/
MM/YYYY.

When you use “Edit Attribute”, you will enter the “Enter attributes” page. To this type of
field, the system will automatically show the date. To change the date, you can directly
tap the icon and set.
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Time: They system will automatically show the time or you can change by tapping.
The time format includes 12 HR and 24 HR.
    
When you use “Edit Attribute”, you will enter the “Enter attributes” page. To this type of
field, the system will show the time automatically. To change time, please tap the icon
and set.
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Photo: The attribute value is a path of photo. You can select a photo file or take a
photo with the camera device of mobile device, and the path of the selected file or of the
photo you just taken will be shown in the field. The photo you take in SuperSurv will
have GSP data and will be saved in the PHOTO folder of project folder. 

When you use “Edit Attribute”, you will enter the “Enter attributes” page. To this type of
field, you can choose a photo or take a photo. Tap the field and a dialog shows up, you
can select choose a photo or camera. 
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Tap “Choose a photo”, specify a photo file and the path of the photo file will be input
automatically.

Choose “Camera”, it enters camera mode. After you take a photo, the path of the photo
file will be automatically shown in the field. The coordinate values will be saved to the
file and photo file will be saved to the project folder.

GPS: The system will automatically record the GPS coordinates of the position of the
feature or you can change manually. You need to specify the XYZ value. Please note
that this type is available for point layer only

When you use “Edit Attribute”, you will enter the “Enter attributes” page. To this type of
field, the specified coordinate value will be recorded as the attribute value.
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Length:the system will calculate and record the length of the line feature as the
attribute value or you can change manually. Please note that this type is available for
line layer only. 

When you use “Edit Attribute”, you will enter the “Enter attributes” page. To this type of
field, the length will be recorded as the attribute value, the unit is meter.
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Area: The system will calculate and record the area of the polygon feature as the
attribute value, or you can change manually. Please note that, this type is available for
polygon layer only.
 

When you use “Edit Attribute”, you will enter the “Enter attributes” page. To this type of
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field, the area of the feature will be recorded as the attribute value, the unit is square
meter.

Numeric: The attribute value should be an integer and input manually.

When you use “Edit Attribute”, you will enter the “Enter attributes” page. To this type of
field, you need to input an integer as the attribute value.
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Menu: When you are entering the attribute value, the field will provide with a menu or
automatically filter the text that is entered and display the suitable one for users to
choose.
    

Tapping  can add the menu item, and the window of figure below will appear for you
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to enter the name of menu item.

If you choose Menu, when you use “Edit Attribute”, you will enter the “Enter attributes”
page. To this type of field, you can tap the drop-down menu and choose one item as
the attribute value.
      



Detailed Function Description

127

If you choose AutoComplete, when you use “Edit Attribute”, you will enter the “Enter
attributes” page. To this type of field, you need to enter the attribute value manually,
and system will auto-filter and present the suitable one for you to choose. Then, you
can just tap the one that matches.
    

In addition, when you are editing the field, in the “Create a new layer” page, you can
long-press a field and a menu appears. With the menu, you can tap “Delete” to delete
the field; tap “UP” and “Down” to change the order.
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Video: The attribute value is a video file path. Users can select a video file or record a
video with the device’s built-in recording function. As the file is specified or video has
been recorded, the video file path will be presented as the attribute value. The file format
supports what the device supports.  
            

When you use “Edit Attribute”, you will enter the “Enter attributes” page. To this type of
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field, it shows “Choose a video or record a video”, tap it and a dialog shows up with two
options: choose a video or record a video.
    

If you want to choose a video, please specify a video and the file path will be presented
in the field. If you choose record a video, the device will switch to video mode, when the
video is finished, the file path for the video will be presented in the field.
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Undo/Redo

Undo/Redo

1. In edit mode, you can undo by tapping . 

Select Feature

Select Feature

1. If there is a existing feature, go to add feature and tab  swift to edit mode.
Then you can edit existing feature mode.
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2. Then you can delete, move, edit attribute a specified feature.

Delete Feature

Delete Feature

1. After a feature is selected, tap . Then a confirming dialog shows up. Please tap
OK and delete the selected feature.
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Edit Attribute

Edit Attribute

1. Select a feature > long-press the selected feature > attributes edit page appears.
Please enter the attribute data. When you create the layer, you will need to enter the
attribute value manually. Some attribute values will be given automatically when
creating the feature, such as date, time, XYZ coordinate values (for point layer),
length (for line layer), area(for polygon layer), but you can change them manually. 
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If you have set the custom table, when you are editing attribute, the system will offer
you a quick way to input data based on the field type. For instance, in date field, you
can input data by tapping.
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Add A Vertex at GPS Position

Add A Vertex at GPS Position 

To add point features or vertices of line or of polygon features, you can tap   to add
a vertex at GPS position.
A vertex is added at the GPS location. Tap, and the feature is successfully created.

Collect Data with GPS Automatically

Collect Data with GPS Automatically

1. Before using this function, please make sure GPS works correctly. You can
continuously add points at GPS positions through the GPS data, which allows you to
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add line or polygon features. Firstly, add a line or polygon feature, here we illustrate

with a line feature. Add the first vertex of the line feature, tap  >  A message
shows up: "Whether to collect data with GPS automatically"  > Please tap OK.

2. When you are moving, the vertices will be added to the map based on the GPS data.

To stop collecting GPS data, tap  to finish the editing. Tap OK , and you will
see the new feature on the map. 

Set Survey Toolbar

Set Survey Toolbar

Tap , the survey toolbar setting page appears. Five items:
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Input attributes after creating a feature: If set it On, the attribute table window shows
up right after a feature is created. If set it Off, no attribute table window shows up after
a feature is created; in that case, to edit attribute you need to select the feature first
and use "Edit Attribute" so the attribute table windows will appear. 

Outline color when editing feature: Set the outline color when editing feature.

Snap to vertex when editing feature: When editing features, the new or editing feature
is able to snap to other existing feature within the specified tolerance. Users can
switch on/off the function, the unit is pixel.

Please note that, to activate snapping when editing features, firstly, you need to set
"Snap to vertex when editing features" on and specify the tolerance. Sequentially, 

SuperSurv allows snapping vertices with tolerance automatically. To snap two vertices,
please select the feature to snap and then activate Move Vertex function so that you
can pan vertex A which you want it to be snapped to vertex B by approaching to vertex
B. As the distance between the two vertices is shorter than tolerance (you set in Snap
to vertex when editing features, the unit is pixel), vertex A will be snapped to vertex B
automatically. Please refer to the illustration below. 
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Add a vertex by GPS average: The function used to collect and add point(s) or
vertices of point, line and polygon layer. 

(1) Time: Please fill in the blank with a number which will stand for the time interval
(second) for GPS to add a vertex. Fill in with 1; the GPS adds a vertex every second.
Fill in with 2; SuperSurv will average the positions of the collected vertices every 2
seconds and adds the point/vertex on the map.

(2) Position: The Point setting is for collecting point data while the Vertex setting is
applicable for collecting the vertices of line/polygon data. Please fill in the blank you
require with a number. Fill in with 1; the GPS adds every point it collected. Fill in with 2;
SuperSurv now averages positions of every 2 vertices it collected and adds the vertex on
the map.
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Continuous GPS Position: The function used to collect data (or vertices) of point, line
and polygon layer.

(1) Time interval: Please fill in the Time interval with an integer which stands for the time
interval (second) for GPS to add a vertex. If you fill in with 1, SuperSurv will add its
position every second. Subsequently, fill in the blank of Distance with a number which
represents the distance (meter) threshold for the data collection. Fill in with 1;
SuperSurv will add every next point while the distance among them is at least 1 meter.

(2)Position interval: Please fill in the blank of Position interval with an integer which
stands for the specified points collected by GPS. Fill in with 1; SuperSurv will add every
collected point on the map. Fill in with 2; SuperSurv will add the even points it collected.
Subsequently, fill in the blank of Distance with a number which represents the distance
(meter) threshold for the data collection.

Synchronizing Feature Service to Server

Synchronizing Feature Service to Server

When editing SuperGIS Server layer, a message will show up to confirm whether you
want to synchronize data with Server after a feature is added, please tap Yes to
synchronize, otherwise, tap No.

    

After inputting attribute data in Enter attributes dialog, please tap OK(Synchronize) to
synchronize the attribute data with Server.   
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Waypoint

Waypoint

There are two ways to create waypoints: you can select a file and import waypoints or
create new waypoints on SuperSurv. As the waypoints are created, the waypoint
guidance will appear. The waypoint guidance can help users to know the position you
are and where the destination is. Moreover, users can pan to, edit, delete, export, and
import waypoints. 

Create Waypoints by GPS

Adding Waypoints

In field survey,  you  might  need  to  add  some  points  to  survey  temporarily  because  of
accidents or missions. Then, you can create new waypoints  to complete the operation.
Or  when  you  are  surveying,  you  might  need  to  add  some  point  information  (e.g.
building, tree, etc.) for references, you also can apply waypoints to achieve the target. 
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1. Press menu > Add Waypoint.

2. Tab the place you want on the map or tab  to set waypoint and "Add
Waypoint" window shows up, please select the coordinate system, and enter
waypoint name and Z value. The coordinate fields (longitude, latitude, elevation)
shows the current coordinates. You can modify the coordinate values manually.
Please tap OK to finish.
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3. Waypoint is successfully added. The name of waypoint is also displayed on the
map. 
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Note:
The function can be worked with Positioning function to rapidly zoom to the target
position and add the new waypoint by long-pressing.
You can also use waypoints as an annotation of points on the map.

Pan to

Pan to 

The system provides two ways to position, including Pan to GPS, and Pan to waypoint.
Users can choose the way of positioning they need according to their situation.



Detailed Function Description

143

Waypoint Guidance

Waypoint Guidance

As GPS is used, you can select a waypoint as the destination of the waypoint guide.
The system will calculate the shortest straight line distance between the current GPS
position and waypoint; an orange dashed line will be connected between the two points
on the map. Also, the information of waypoint guidance will appear on the top of the
map and guide the users to the destination. 

1. Tap    you would like to see the guidance. 

2. Select the waypoint you need from Guide to Waypoint page. If you would like to clear
waypoint guidance, select ??Waypoint guidance clear?? and the guidance will be
cleared. 
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Guidance information includes:  
(1) Waypoint name
(2) Switch to the shortest straight line distance between current GPS position and
waypoint destination
(3) Switch to waypoint guidance
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AR

AR

Activate AR(Augmented Reality), the waypoints which are located within 700 meters
away from the GPS position will show up as a tag with waypoint name and distance.
And the radar at the upper right corner shows to identify the relative direction in between
all waypoints.
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Waypoint Management

 How  to create w aypoint f ile?

How to create waypoint file?

You can create waypoint files on PC and then copy the files to the mobile device. Then,
you can import the waypoints to SuperSurv. SuperSurv supports to import waypoints in
TXT, CSV, or KML file. If you use TXT and CSV format, please follow the rules below: 

Column names: the order is Name, X, Y, and Z. They stand for waypoint name, X
coordinate, Y coordinate, and elevation. 
Punctuation: use comma????to split each column. 
Coordinate system: XY coordinates can be projected system or WGS84 format. If
you use WGS84, please use degree. 
Z value: Z value is the elevation of waypoint. The unit is meter. Z value is an optional
column; you can choose whether to enter the value.
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 Importing Waypoint

Importing Waypoint 

Users are allowed to importing waypoints to SuperSurv. The system supports to import
TXT, CSV, or KML format; the imported XY coordinates can be displayed as points to
help you recognize the actual positions of the points on the map. 

1. In SuperSurv, tap menu > Add Waypoint. > Tap settings button  on waypoint
toolbar.
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2. In Waypoint management window, tap import. 
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3. Select the file you created in Step 2, and tap OK. 
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4. Back to waypoint management window, tap Back key, and the message appears.
Tap Yes. 

5. Back to the map, and you can see the imported waypoints. The icon on the
map stands for the position of waypoint. The waypoint name is disaplyed above
the icon. 
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 Adding Waypoints

Adding Waypoints

In field survey,  you  might  need  to  add  some  points  to  survey  temporarily  because  of
accidents or missions. Then, you can create new waypoints  to complete the operation.
Or  when  you  are  surveying,  you  might  need  to  add  some  point  information  (e.g.
building, tree, etc.) for references, you also can apply waypoints to achieve the target. 

1. Press menu > Add Waypoint.
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2. Tab the place you want on the map or tab  to set waypoint and "Add
Waypoint" window shows up, please select the coordinate system, and enter
waypoint name and Z value. The coordinate fields (longitude, latitude, elevation)
shows the current coordinates. You can modify the coordinate values manually.
Please tap OK to finish.
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3. Waypoint is successfully added. The name of waypoint is also displayed on the
map. 
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 Edit/Delete Waypoint

Edit/Delete Waypoint 

Manage Waypoint page list all the imported and added waypoints. You can edit, delete,
import, and export the waypoints. The following describes the way to edit and delete. 

1. Tap 
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2. Manage waypoint page appears. You can select the waypoint you need on th left and
then tap the items on the right to edit the waypoints. If no waypoint is selected and
you tap an item on the right, the message will appear to remind you to select a
waypoint. 

Edit: You can edit the name, longitude, latitude, z value (altitude) of the selected
waypoint. 
1. You can select a waypoint to edit; the selected waypoint will be marked with green. 
2. Tap Edit. 
3. Waypoint page appears; you can edit the name, longitude, latitude, and z value

(altitude). 
4. Tap OK to complete edit. 



SuperSurv 10 Help

156

Delete: Delete the selected waypoint. 
1. Select the waypoint you would like to delete. The selected waypoint will be marked

with green. 
2. Tap Delete. 
3. The warning message appears, ??Are you sure to delete the waypoint???
4. Tap yes, and the waypoint will be deleted. Tap Back key, the message will

appear, ??Do you want to save the waypoints???Tap Yes. 
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Delete All: Delete all the waypoints. 
1. Tap Delete All. 
2. The warning message will appear, ??Are you sure to delete all waypoints???Tap

yes. 
3. Back to Manage Waypoint page, you can see all the waypoints are deleted. Tap

Back key, and the message will appear, ??Do you want to save???Then tap yes. 
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Note:
Deleting waypoints only deletes the added and imported waypoints that will neither
delete the original waypoint file nor modify the data in the file.

 Show  Waypoints

Show Waypoints

You can choose whether to show the waypoints on the map. If you check Show
Waypoints, all the waypoints and waypoint names will be displayed on the map. If
Show Waypoints is not checked, no waypoint will be displayed on the map.
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 Exporting Waypoints

Exporting Waypoints

Through exporting waypoints, you can export all the waypoints (including the imported
waypoints and newly added waypoints) as TXT, CSV, or KML files. And the waypoints
can be used for further application. 

1. In SuperSurv, tap menu > Add Waypoint. > Tap settings button  on waypoint
toolbar. 
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2. In Waypoint management window, the waypoints will be listed on the left, and Export
is on the right. You can export all the waypoints as files. 



Detailed Function Description

161

3. Enter the file name and choose the file format to export. There are 3 formats, KML,
TXT, CSV. After setting, please tap OK.

The waypoint is exported successfully. The message will show up and display the path.
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Note:
If there is no waypoint in the system, the message ??There is no waypoint??will
appear.

    

3.6 Manage Layer

Add Layer

Add Layer

After the layers are created, you can add layers to the map. 

The layers that are not chosen will not be display on the map. Tap  , and all the
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layers are listed here. Or you can copy the layer you want to add, and paste it to the
folder. Back to SuperSurv, the map displays the selected layers. 

Original layer
Copy all the project files into

layer folder

Open SuperSurv again, the
new layer will show up in the

list

How to add the existing layers to SuperSurv map? To add existing layers to use in
SuperSurv please copy the existing layers to Layer folder of SuperSurv folder, start
SuperSurv, so that the Add Layer list will include the added layers. Check the layers to
display and you can see them displayed on the map. 

If you have no available layers, please create a new layer. Tap and choose a
type of layer you want.
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In the  setting  page,  please  enter  the  layer  file  name,  layer  name,  select  code  page,
layer type (point, line, polygon) and choose the file format  (SHP or GEO).  After setting
is finished, tap OK.  
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Field setting dialog appears, choose Start to Customize Table, and tap OK. 

In “Create a New Layer”, set the field name and field properties. You can tap a field to
set the field format in Field Setting. 
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To create a new field, please tap , “Create a new field” appears. Please select a field
type and set the format. About the details of the field type and format, please refer to 
Custom Table.
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After the setting is finished, please tap OK and back to the map. Survey toolbar shows
up on the top of the map.  
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Then, there are two modes. One is add . The other one is edit . When it
is add mode, you can choose type of layer, and create features.
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After a feature is created, if you would like to enter attribute data, you can long-press
the feature you created in edit mode. Then the attributes page will show up. 

 
You can edit the attribute data in Enter Attributes page. 
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Also, you can edit the attributes right after a feature is created. Please tap Survey

Setting , and set “Input attributes after creating a feature” as On and tap OK. Back
to the map, you can see Enter Attributes page right after a feature is created.
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Add GeoSpatialPDF Layer

Add GeoSpatialPDF Layer

1. Go to menu and create a new project. Then tap . If there is no layer exist, the
notice window will show up.
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2. Copy GeoSpatialPDF file and paste it into the specified folder. 
For example, if the name of your project is "AAA", you can find a "AAA" folder in your
mobile device.Then open it, you can find a 'layer' folder.  
Paste the GeoSpatialPDF file into the layer folder.



Detailed Function Description

173

3.  Tap  , then you can see the result.

Upload Layer to Google Drive and Dropbox

Upload  Layer to Google Drive and Dropbox

You can add layer from google drive or dropbox.
1. Google Drive

Tap . Go to layer setting page. Then tap . Chose "upload to Google
Drive."
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Open your google drive, then you can see the uploaded files.
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2. Dropbox

Tap . Go to layer setting page. Then tap . Chose "upload to "Dropbox."
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Open your Dropbox, then you can see the uploaded files.
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Layer Setting

Layer Setting

With Layer Management, you can add a layer to the map and set the properties of the
layer. If you create a new layer, you can customize tables to enter the attribute data
rapidly.
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Take layer of polygon for example. There are six items.
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File name : show the file name.
Layer name : show the layer name.
Label setting : swift on/off label setting, and select the items you want.
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Current style : choose the style.
Frame : including three items, style, width of line and color.
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Pattern : including two items, style and color.
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3.7 GPS

GPS

GPS functions enable you to rapidly recognize the current position when you are
surveying outdoor. With Waypoint, the status bar can show the guidance (refer to 
Waypoint). With track, users can record the path users passed by (refer to Track).
GPS functions include whether to user GPS, GPS position, and View location



Detailed Function Description

183

information. 

SuperSurv supports to position with GPS by using satellite or using internet. If you are
in a area where the mobile device can receive satellite signal well, SuperSurv will

position with satellite and display GPS position with  on the map. If the satellite
signal is poor, SuperSurv will start AGPS function automatically to help find the GPS
position.

Whether to Use GPS

Whether to Use GPS 

1. To display the current GPS position on the map, please tap   on the upper-right

corner to pan to the current GPS position. Then, a purple mark  will be displayed
on the map. The fan-shaped area is the visual angle. The longitude and latitude
information will be displayed on the top of the map; tapping the information can
convert to project coordinate system. 
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Note:
After using GPS, you can use waypoint guidance and track record to help you have
the guidance and track recording.
If GPS is not used or no GPS signal is poor, waypoint guidance will be closed, track
recording function will be stopped as well.

GPS_StatusBar

GPS Status Bar

After activating GPS, the GPS status bar will show on the main screen and display
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location and satellite information. You can continuously tap status bar to view different
location and satellite information, including longitude/latitude, XYZ (coordinate
information from current projection), satellite information and accuracy.
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If you want to view all information at once, tap satellite button .

Users can set display information in Menu > Settings/View > Map element and tap
setting > GPS information.
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GPS Positioning

GPS Positioning

GPS Positioning allows to place GPS current position to the map center according to
the current scale. The function only works when GPS is used. If you have not used
GPS, please refer to Whether to Use GPS. After GPS positioning works successfully,
you can see the coordinates of the current position on the GPS status bar on the top of
the map. 

1. Tap GPS positioning on the toolbar. 
   

2. According to the current scale of the map, SuperSurv pan the GPS position to the
map center. The GPS status bar displays the coordinates of the current position.
You can tap the blank of the bar to switch longitude and latitude to projected
coordinate system and GPS status. 



SuperSurv 10 Help

188

You can also have GPS show your current position and GPS position remain in map
center.

1. Users can choose a GPS signal through GPS Settings. You can setup the detailed
positioning data source you need, and SuperSurv is using Internal GPS signal as
default.



Detailed Function Description

189

 

For using the external positioning sources, SuperSurv 10 allow user to connect to
various of external GNSS receiver via Bluetooth communication. Please make sure the
Bluetooth function had been turned on and already finish pairing with the external GNSS
receiver. (Please notice: If you occur any trouble while pairing the Bluetooth external
GNSS receiver with your Android device, we suggest you contact your hardware
provider for further support.)
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Next, please select the type of your external GNSS receiver. If the device you are using
is the basic or consumer type of GNSS and will output the NMEA automatically, please
select the General Device. If the device you are using is the mainstream profession
high-accuracy GNSS receiver and is supported by SuperSurv, please select the
corresponding option in the drop down list.
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Now you can select the Bluetooth GPS in the Signal Source drop down list, and
SuperSurv will start linking to the external Bluetooth GNSS receiver automatically. Start
positioning and survey with your external Bluetooth GNSS device now!
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If your external Bluetooth GNSS receiver support NTRIP service and RTCM, you can
simply setup the detailed settings and apply the linkage. Now SuperSurv 10 support
about 80% GNSS module from 3 mainstream manufacturers: U-Blox, Hemisphere and
NovAtel. After you enter the IP and Port of your NTRIP service caster, tab on the Get
MountPoint button to receive the service list and select the option you want to apply
with. After finishing setup, turn on the NTRIP service and SuperSurv will automatically
receive the RTCM data and sent them to your external GNSS receiver via Bluetooth
communication. If the RTCM data could be solved by the GNSS module, you will be
having more accuracy positioning data for your field work.
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2. Tapping OK to complete the configuration. And you can view GPS position refreshed
automatically on map in traveling.

View Location Information

View Location Information

The information related to GPS satellite contains General, Details, and Satellite. The
information can be viewed only when GPS is being used. 

1. Tap Menu key > Settings/View > View location information. 

2. View location information. 
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(1) General

 Sky map displays satellites connected with the device at the current
position. 
 Each spot represents one satellite and users can distinguish the
satellite  services from its color. 
 SuperSurv supports to capture location information from :

GPS (Blue)
GLONASS (Green)
Galieo (Yellow)
BeiDou (Red)
SBAS (violet)

 Location source: to get the location source

Satellites : Number of satellites
Longitude: longitude position
Latitude: latitude position
Altitude: the altitude calculated from sea level
Speed: the speed your move

(2) Details
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 You can view the common GPS information here. 
Location source : to get the location source
Date and Time : date and time
Longitude : the longitude position you are
Latitude : the latitude position you are
Altitude : the altitude of the position you are.  The way to
calculate is from the sea level; the unit is meter.
Speed : the speed your move
Direction : the direction you face 
PDOP : Positional Dilution of Precision
HDOP: Horizontal Dilution of Precision
VDOP: Vertical Dilution of Precision

(3) NMEA

 The protocol, made by National Marine Electronics Association,
NMEA, is used to define the communication 
 among data and data format. 
 Tap Save, you can save the data as a file in txt format.

3.8 Track

Track

Track functions include “track recording” and “Import/ close reference track.” Track
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recording helps you record the path you pass by outdoor, and the track can be used for
further application. Or next time when you are in field survey, you can apply display
track on the map for references. The detailed functions will be described below. 

Start to Record Track

Start to Record Track

“Start to record track” enables you to record the track received by GPS and helps you
know the path you pass by. 

1. Tap Menu > Settings > Plugin Settings > Check Track.

2. Back to main window, tap Plugin Settings  > Track  > Record , and
track toolbar appears on the right. 
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Pause/Start to Record

Pause/Start to Record

“Pause/start to record” enables you to pause to record track and start to record track
after pausing. In a survey, if you pass some areas where GPS signal is weak (e.g.

tunnel, forestry), you might want to pause to record. Then, you can tap  on the
upper-right corner, the track record will be paused. The upper-left information will be 

. When you want to keep recording, please tap , the upper-left corner will

become  and the system keeps record. You can pause and record track more than
once, but the track will be saved in the same file. 

Stop Recording

Stop Recording 

When the system is recording track, you can stop recording anytime. Tap  , the
system will save the current track. The upper-left information will become 

. The file will be named with year, month, date, and order. The file can
be saved as point layer (*.kml and line layer (*.shp. The file will be saved in the Track
folder in the project folder.   

In addition, after stopping recording, the Tracking Record Finish Length will display
on screen. To close track recoding function, please tap Track > Record again.
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Note:
The track file is named with YYYYMMDD_XX YYYY is year; MM is month; DD is
date; XX is the order of the files created on the same date. The number starts from 01.
For example: 20110328_02.

    

Import Reference Track

Import Reference Track
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Reference Track allows you to import the saved track file (the file format should be
SHP), and the map can be panned to the track. 

1. Tap Track > Reference . If there is no track file in the folder, the message “there
is no available track” will appear. 

    
2. The window “Import reference track” appears. Select the track file you would like to

import and tap OK. 

3. Import reference track, and the map will be panned to the track and displayed with
purple line.
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Close Reference Track

Close Reference Track

“Close reference track” can clear the imported reference track on the map. As the
reference track is imported, you can close the reference track anytime. 

1. Tap Track > Reference . 
    
2. Tap “close reference track” in the menu, and tap OK. 
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3. The imported track is cleared.

3.9 Query

Query

The system provides 2 methods to query: Attribute Query and Identify Query. If you
would like to use Attribute Query, you need to set the conditions first. Then, the feature
(s) that meet the conditions and its attributes will be displayed on the map. Attribute
Query only allows users to query a single layer. If you use Identify Query, you need to
specify the fields you would like to query. Then, tap the feature you would like to query,
and the results will be displayed on the map. Identify Query allows users to query
multiple layers. If you would like to use query function, please set the layer and fields
first. SuperGIS Server layer (Feature Service) is able to be queried as ordinary layer.
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Set the Layer and Field

Set the Layer and Field

The system provides 3 methods to query: attribute query, identify query and coordinate
query. 

1. Firstly, you need to set the query conditions, tap Query , and then query
selection will pop up. 
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2. Tap settings  to set the settings. Attribute Query only allows users to query a single
layer; Identify Query allows users to query multiple layers, you can select all layers
by checking “Select All.” Coordinate query enables users to query the coordinate
information by tapping. 

3. After setting the layers, the layer you set to query will be displayed below Setting.
Then, you can set the fields you would like to query of each layer. Both Attribute
query and Identify query are able to set to query multiple fields or you can check
“Select All” to select all fields. Attribute Query and Identify Query both allows users
to set multiple fields. After setting, please tap OK. Then, back to Set Query
Conditions page, the fields you set to query will be listed here as well. 
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4. As the setting is finished, please tap Back key on the mobile device, and tap yes in
the dialog. 

5. Back to the map, and you can start to query. Tap Query  > Select Attribute
Query. Then, the dialog shows up; please set the key words, value, or range. Or you
can fuzzy inquiry by entering some key conditions. Tap OK. The features that meet
the conditions will be displayed and panned to the map center. 
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SuperGIS Server layers can be queried as the ordinary layers. All layers contained in
the SuperGIS Server layer will be listed for user to select. And the way to query
SuperGIS Server layers are the same as to query ordinary layers.

Attribute Query

Attribute Query

1. Tap , and then select Attribute query , query conditions window appears. 
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2. Please enter the conditions, or use fuzzy inquiry, and tap OK.The feature(s) that
meet the conditions will be marked, and the attributes of the features will be
displayed. 
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Identify Query

Identify Query

1. Tap   > select identify > tap the feature you would like to query, and the feature
will be marked.
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Coordinate query

Coordinate query

1. Tap Query   

2. Select Coordinate query from the pop-up window.

3. Tap on screen where you want to query. 

4. SuperSurv will show the query result, including Longitude/Latitude and coordinate
information from current projection system.
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3.10Measure

Measure

The measure tools provide length measurement and area measurement. The units for
length measurement include meter, kilometer, mile, and feet. The units for area
measurement include square meter, hectare, square kilometer, square feet, and acre.
To know how to switch between metric units and imperial units please refer to  
Dimension Setting(Measure Function).

Length Measurement

Length Measurement 
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While manipulating with SuperSurv, you can measure the map anytime. 

1. Tap Measure . 

    
2. Enter into Measurement mode. 

3. Tap Length Measurement .  

4. Tap the map repeatedly to draw the segment you would like to measure. The
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segment you draw will be displayed as a red line. 

5. Tap Undo , and you can undo the previous measurement. 
    
6. The system will calculate the total length of the segment you draw on the map. The

results will be displayed on the map.

Area Measurement

Area Measurement

While manipulating with SuperSurv, you can measure the map anytime.
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1. Tap Measure  Tap  button until the button icon change to Area

Measurement .

2. Tap the map repeatedly to draw an area you would like to measure. The area will be
framed with red lines. 

3. Tap Undo , you can undo the previous measurement. 
    

4. The system will calculate the area of the rectangle you draw on the map. The
measure results will be displayed on the map. 
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Feature Measurement

Feature Measurement

This tool allows you to measure features. To SuperGIS Server layer features, Feature
Measurement tool also works on it.

1. Tap Measure > Tap until the button icon change to Measure

Features .
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2. Tap on the feature you want to query and the result shows up in different type
depending on the feature type.
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Note:                                                   
The length units include: meter and kilogram. (The length longer than 1000 m will be
displayed with km.)
The area units include square meter (the area larger than 10000 square meters will be
displayed with hectares), hectare, and square km (the area larger than 1000 hectares
will be displayed with square kilometers). 
The message below will show up if you are measuring but switch to different
measurement or tap finish measurement. Tap OK and the current measurement will
be canceled.
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